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Step One:
If you shoot in JPEG or TIFF mode (or 
JPEG + Raw), you’ll want to set your cam-
era’s color space to match what you’re 
going to use in Photoshop for your color 
space (to get consistent color from your 
camera to Photoshop to your printer, 
you’ll want everybody speaking the 
same language, right?). I recommend 
you change your camera’s color space 
from its default sRGB to Adobe RGB 
(1998), which is a better color space for 
photographers whose final image will 
come from a color inkjet printer.

Step Two:
On a Nikon DSLR, you’ll usually  
find the Color Space control under the 
Shooting Menu (as shown here at left). 
On most Canon DSLRs, you’ll find the 
Color Space control under the Shooting 
2 menu (as shown here on the right). 
Change the space to Adobe RGB. If 
you’re not shooting Nikon or Canon, 
it’s time to dig up your owner’s manual  
(or, ideally, download it in PDF format 
from the manufacturer’s website) to find 
out how to make the switch to Adobe 
RGB (1998). Again, if you’re shooting in 
RAW, you can skip this altogether.

Although there are entire books written on the subject of color management, in 
this chapter we’re going to focus on just one thing—getting what comes out of 
your color inkjet printer to match what you see onscreen. That’s what it’s all about, 
and if you follow the steps in this chapter, you’ll get prints that match your screen. 
We’re going to start by setting up your camera’s color space, so you’ll get the best 
results from screen to print. Note: You can skip this if you only shoot in RAW.

Setting Up  
Your Camera’s  

Color Space
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Resolution  
for Printing

Step One:
To see what your current photo’s resolu-
tion is, go under the Image menu and 
choose Image Size (or press Command-

Option-I [PC: Ctrl-Alt-I]). Ideally, for print-
ing to a color inkjet printer, I like to be at 
240 ppi (pixels per inch), but I often print 
at 200 ppi, and will go as low as 180 ppi 
(but 180 ppi is absolutely the lowest I’ll go. 
Anything below that and, depending on 
the image, you’ll start to visibly lose print 
quality). So, I guess the good news here 
is: you don’t need as much resolution as 
you might think (even for a printing press).  
Here’s an image taken with a 12-megapixel  
camera and you can see that at 240 ppi, 
I can print an image that is nearly 12x18".

Step Two:
Here’s the resolution from a 6-megapixel 
camera. At 240 ppi I can only print an 
8x12.5" image. So, to make it larger, I turn 
off the Resample Image checkbox, type 
in 200 as my new resolution, and then I’d 
have an image size of 10x15" (with no loss 
of quality). If I lower it to 180 ppi (as low 
as I would ever go), then I get the print 
up to a finished size of 11x16.75" (nearly 
that of a 12-megapixel camera), and I 
did it all without losing quality (because  
I turned off the Resample Image check-
box, but before you do this, you need  
to read about resizing in Chapter 4 in  
the book).

This is one of those topics that tend to make people crazy, and since there is  
no Official Board of Resolution Standards, this is the type of thing that gets ar-
gued endlessly in online discussion forums. That being said, I take the word of  

my friend and fellow photographer Dan Steinhardt from Epson (the man behind 
the popular Epson Print Academy), who lives this stuff day in and day out (Dan  
and I did an online training class on printing and this was just about the first topic 
we covered, because for so many, this is a real stumbling block). Here’s what we do:
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Step One:
Before we do this, I just want to reiterate 
that you only want to make this change 
if your final print will be output to your 
own color inkjet. If you’re sending your 
images out to an outside lab for prints, 
you should probably stay in sRGB—both 
in the camera and in Photoshop—as most 
labs are set up to handle sRGB files. Your 
best bet: ask your lab which color space 
they prefer. Okay, now on to Photoshop: 
go under the Edit menu and choose 
Color Settings (as shown here).

Step Two:
This brings up the Color Settings dialog.  
By default, it uses a group of settings 
called “North America General Purpose 
2.” Now, does anything about the phrase 

“General Purpose” sound like it would be 
a good space for pro photographers? 
Didn’t think so. The tip-off is that under 
Working Spaces, the RGB space is set to 
sRGB IEC61966–2.1 (which is the long-
hand technical name for what we simply 
call sRGB). In short, you don’t want to 
use this group of settings. They’re for 
goobers—not for you (unless of course, 
you are a goober, which I doubt because 
you bought this book, and they don’t sell 
this book to goobers. It’s in each book-
store’s contract).

Photoshop’s default color space is sRGB (some pros refer to it as “stupid RGB”),  
which is fine for photos going on the web, but your printer can print a wider range 
of colors than sRGB (particularly in the blues and greens). So, if you work in sRGB, 
you’re essentially leaving out those rich, vivid colors you could be seeing. That’s why 
we either change our color space to Adobe RGB (1998) if you’re shooting in JPEG or 
TIFF, which is better for printing those images, or ProPhoto RGB if you shoot in RAW 
or work with Photohsop Lightroom. Here’s how to set up both:

Setting Up 
Photoshop’s  
Color Space
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Step Three:
To get a preset group of settings that’s 
better for photographers, from the 
Settings pop-up menu, choose North 

America Prepress 2. Don’t let it throw 
you that we’re using prepress settings 
here—they work great for color inkjet 
printing because it uses the Adobe RGB 
(1998) color space. It also sets up the 
appropriate warning dialogs to help  
you keep your color management plan  
in action when opening photos from 
outside sources or other cameras (more 
on this on the next page).

Step Four:
If you’re shooting in RAW exclusively,  
or using Lightroom (Adobe’s awesome 
application for photographers), then 
you’ll want to change your color space 
in Photoshop to ProPhoto RGB to get 
the best prints from your RAW images 
(plus, if you use Lightroom, you’ll wind 
up moving images back and forth be-
tween Lightroom and Photoshop from 
time to time, and since Lightroom’s na-
tive color space is ProPhoto RGB, you’ll 
want to keep everything consistent. While 
you might use Lightroom for your JPEG 
or TIFF images, there’s really no advan-
tage to choosing ProPhoto RGB for them). 
You change Photoshop’s Color Space to 
PhotoPro RGB in the Color Settings dia-
log (just choose it from the RGB menu, as 
shown here). That way, when you open 
a RAW photo in Photoshop (or import 
a file from Lightroom), everything stays 
in the same consistent color space and 
if you wind up bringing an image from 
Lightroom over to Photoshop, and end up 
printing it in Photoshop (instead of jump-
ing back to Lightroom for printing), you’ll 
get better results.
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Step Five:
About those warnings that help you keep 
your color management on track: Let’s 
say you open a JPEG photo, and your 
camera was set to shoot in Adobe RGB 
(1998), and your Photoshop is set the 
same way. The two color spaces match, 
so no warnings appear. But, if you open 
a JPEG photo you took six months ago, 
it will probably still be in sRGB, which 
doesn’t match your Photoshop working 
space. That’s a mismatch, so you’d get the 
warning dialog shown here, telling you 
this. Luckily it gives you the choice of how 
to handle it. I recommend converting that 
document’s colors to your current working 
space (as shown here).

Step Six:
You can have Photoshop do this conver-
sion automatically anytime it finds a  
mismatch. Just reopen the Color Settings 
dialog, and under Color Management 
Policies, in the RGB pop-up menu, change 
your default setting to Convert to Work

ing RGB (as shown here). For Profile Mis
matches, turn off the Ask When Opening 
checkbox. Now when you open sRGB 
photos, they will automatically update to 
match your current working space. Nice!

Step Seven:
Okay, so what if a friend emails you a 
photo, you open it in Photoshop, and  
the photo doesn’t have any color profile  
at all? Well, once that photo is open in 
Photoshop, you can convert that “un-
tagged” image to Adobe RGB (1998) by 
going under the Edit menu and choosing 
Assign Profile. When the Assign Profile 
dialog appears, click on the Profile radio 
button, ensure Adobe RGB (1998) is se-
lected in the pop-up menu, then click OK.
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Step One:
Start by doing a trick my buddy Shelly 
Katz shared with me: duplicate the Back
ground layer (by pressing Command-J 

[PC: Ctrl-J]) and do your print sharpening 
on this duplicate layer (that way, you don’t 
mess with the already sharpened original 
image on the Background layer). Name 
this new layer “Sharpened for Print,” then 
go under the Filter menu, under Sharpen, 
and choose Unsharp Mask. For most 
240 ppi images, I apply these settings: 
Amount 120; Radius 1; Threshold 3. 
Click OK.

Step Two:
Next, reapply the Unsharp Mask fil-
ter with the same settings by pressing 
Command-F (PC: Ctrl-F). Then, at the 
top of the Layers panel, change the layer 
blend mode to Luminosity (so the sharp-
ening is only applied to the detail of the 
photo, and not the color), then use the 
Opacity slider to control how much sharp-
ening is applied. Start at 50% and see if it 
looks a little bit oversharpened. If it looks 
like a little bit too much, stop—you want 
it to look a little oversharpened. If you 
think it’s way too much, lower the opacity 
to around 35% and re-evaluate. When it 
looks right (a little too sharp), make a test 
print. My guess is that you’ll want to raise 
the opacity up a little higher, because it 
won’t be as sharp as you thought.

When we apply sharpening, we apply it so it looks good on our computer screen, 
right? But when you actually make a print, a lot of that sharpening that looks fine 
on a 72- or 96- dpi computer screen gets lost on a high-resolution print at 240 ppi. 
Because the sharpening gets reduced when we make a print, we have to sharpen 
so our photo looks a bit too sharp onscreen, but then looks perfect when it prints. 

Here’s how I apply sharpening for images I’m going to print:

Sharpening  
for Printing
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Step One:
First, contact the photo lab where you’re 
sending your image, and ask what color 
profile they want you to use. Chances are 
they are going to want you to convert 
your image to sRGB color mode. I know 
this flies in the face of what we do when 
we print our own images, but I know a 
number of big, high-quality photo labs  
(Mpix included) that all request that you 
convert your images to sRGB first, and 
for their workflow, it works. If they don’t  
request you convert to sRGB, they may 
have you download a color profile they’ve 
created for you, and you’ll use it the same 
way as you’ll assign sRGB in the next step.

Step Two:
With your image open in Photoshop, go 
under the Edit menu, choose Convert to 

Profile, and you’ll see the image’s current 
color profile at the top of the dialog (here,  
my image is a RAW image, and so it’s 
set to ProPhoto RGB). Under Destination 
Space, from the Profile pop-up menu, 
choose sRGB IEC61966-2.1. If you down-
loaded a profile from your lab, you’ll 
choose that instead (more on where to 
save downloads on page 14). Click OK, 
and don’t be surprised if the image looks 
pretty much the same. In fact, be happy  
if it does, but at least now it’s set up to 
get the best results from your photo lab.

Besides printing images on my own color inkjet printer, I also send a decent amount  
of my print work out to a photo lab (I use Mpix as my lab) for a number of reasons—
like if I want metallic prints, or I want the image mounted, matted, and/or framed  
with glass, or I want a print that’s larger than I can print in-house. Here’s how to 
prep your images for uploading to be printed at a photo lab:

Sending Your Images 
to Be Printed at  

a Photo Lab
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Step One:
I use Datacolor’s Spyder4ELITE hardware 
color calibrator (around $169 street price), 
because it’s simple, affordable, and a lot 
of the pros I know have moved over to it. 
So, I’m going to use it as an example here, 
but it’s not necessary to get this same one, 
because they all work fairly similarly. You 
start by installing the software that comes 
with the Spyder4ELITE. Then, plug the 
Spyder4ELITE sensor into your computer’s 
USB port and launch the software, which 
brings up the main window (seen here). 
You follow the “wizard,” which asks you  
a couple of simple questions (stuff like, 

“Is this the first time you’ve calibrated your 
monitor using Spyder4ELITE?” Or, maybe, 

“What’s the capital of Nebraska?”), and 
then it does the rest.

Step Two:
Start by clicking the Next button in the 
bottom right, and the window you see 
here will appear. If you’re new to calibrat-
ing your monitor, I recommend using the 
Step-by-Step Assistant (which is already 
selected by default), so at this point just 
click the Next button again.

You Have to Calibrate 
Your Monitor Before 
You Go Any Further

If you really want what comes out of your printer to match what you see onscreen,  
then I don’t want to have to be the one to tell you this, but…you absolutely,  
positively have to calibrate your monitor using a hardware calibrator. The good  
news is that today it’s an absolutely simple, totally automated process. The bad  
news is that you have to buy a hardware calibrator. With hardware calibration,  

it’s measuring your actual monitor and building an accurate profile for the  
exact monitor you’re using, and yes—it makes that big a difference.
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Step-by-Step Printing and Color Management009 Bonus Chapter 4

Step Three:
The next screen asks you which type of  
calibration you want to do. Are you going 
to just update an older calibration you 
did previously with the Spyder4ELITE 
(then you would choose the ReCAL radio 
button), or do you just want to check 
to see how accurate your current calibra-
tion is (CheckCAL), or are you doing this 
for the first time (which you are, so you’d 
click the FullCAL radio button, as shown 
here)? Then, just click the Next button, 
because you’re going to leave all the  
pop-up menus here at their default  
recommended settings.

Step Four:
The next screen asks you to put the 
Spyder unit on your monitor, which 
means you drape the sensor over your 
monitor so it sits flat against it and the 
cord hangs over the back. It shows you 
exactly where to place it (the two blue  
arrows you see beside its outline actually 
flash on/off, so you can’t possibly miss 
where it goes). The sensor comes with 
a counterweight you can attach to the 
cord, so you can position the sensor ap-
proximately in the center of your screen 
without it slipping down. Once the sensor 
is in position over your screen, click the 
Next button, sit back, and relax. You’ll see 
the software conduct a series of onscreen 
tests, using gray, white, and various color 
swatches, as shown here.

The Adobe Photoshop CC Book for Digital Photographers (2017 Release)
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Step Five:
This testing only goes on for a few  
minutes (at least, that’s all it took for my 
laptop), and then it’s done. It asks you to 
name your profile (it puts a default name 
in place for you), so enter a name, and 
then click the Save button. Below that is 
a pop-up menu where you can choose 
when you want an automatic reminder 
to “Recalibrate your monitor” to pop up 
on your screen. The default choice is 2 
Weeks (so please don’t tell anyone that 
I actually set mine to 1 Month). Make your 
choice and then click the Next button. 

Step Six:
Now you get to see the usually shock-
ing before/after. Click on the Switch 
button at the bottom right and you 
can switch back and forth between 
your now fully calibrated monitor and 
your uncalibrated monitor. It’s at that 
moment you say, ”Ohhhhhh…that’s 
why my prints never match my screen.” 
Well, it’s certainly one part of the puz-
zle, but without this one critical piece  
in place, you don’t have a chance with 
the rest, so you did the right thing. 
Click Next one last time, and then 
click the Quit button in the Profile 
Overview screen.

The Adobe Photoshop CC Book for Digital Photographers (2017 Release)
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Step One:
Your first step is to go to the website of 
the company that makes the paper you’re 
going to be printing on and search for 
their downloadable color profiles for your 
printer. I use the term “search” because 
they’re usually not in a really obvious 
place. I use two Epson printers—a Stylus 
Photo R2880 and a Stylus Pro 3880—and 
I generally print on Epson paper. When 
I installed the 3880’s printer driver, I was 
tickled to find that it also installed custom 
color profiles for all Epson papers (this 
is rare), but my R2880 (like most print-
ers) doesn’t. So, the first stop would be 
Epson’s website, where you’d click on  
the Printers & All-in-Ones link under Get 
Drivers & Support (as shown here). Note: 
Even if you’re not an Epson user, still  
follow along (you’ll see why).

Step Two:
Once you get to Drivers & Support, find 
your particular printer in the list. Click on 
that link, and on the next page, click on 
Drivers & Downloads (choose Windows 
or Macintosh). On that page is a link to 
the printer’s Premium ICC Profiles page.

The Other Secret to 
Getting Pro-Quality 

Prints That Match  
Your Screen

When you buy a color inkjet printer and install the printer driver that comes with it,  
it basically lets Photoshop know what kind of printer is being used, and that’s about  
it. But to get pro-quality results, you need a color profile for your printer based on  
the exact type of paper you’ll be printing on. Most inkjet paper manufacturers now  
create custom profiles for their papers, and you can usually download them free  
from their websites. Does this really make that big a difference? Ask any pro.  
Here’s how to find and install these profiles:

The Adobe Photoshop CC Book for Digital Photographers (2017 Release)
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Step Three:
When you click that link, a page appears 
with a list of Mac and Windows ICC 
profiles for Epson’s papers and printers.  
I primarily print on two papers: (1) Epson’s 
Ultra Premium Photo Paper Luster, and 
(2) Epson’s Velvet Fine Art paper. So, I’d  
download the ICC profiles for them under 
Glossy Papers (as shown here) and Fine 
Art Papers (at the bottom of the window).  
They download onto your computer, and 
you just double-click the installer for each 
one, and they’re added to your list of pro
files in Photoshop (I’ll show how to choose 
them in the Print dialog a little later). That’s 
it—you download them, double-click to 
install, and they’ll be waiting for you in 
Photoshop’s print dialog. Easy enough. 
But what if you’re not using Epson paper? 
Or if you have a different printer, like a 
Canon or an HP?

Step Four:
We’ll tackle the different paper issue  
first (because they’re tied together).  
I mentioned earlier that I usually print 
on Epson papers. I say usually because 
sometimes I want a final print that fits  
in a 16x20" standard pre-made frame, 
without having to cut or trim the photo.  
In those cases, I use Red River Paper’s 
16x20" Ultra Pro Satin instead (which is 
very much like Epson’s Ultra Premium 
Luster, but it’s already pre-cut to 16x20"). 
So, even though you’re printing on an 
Epson printer, now you’d go to Red River 
Paper’s site (www.redriverpaper.com) 
to find their color profiles for my other 
printer—the Epson 3880. (Remember, 
profiles come from the company that 
makes the paper.) On the Red River 
Paper homepage is a link for Premium 
Photographic Inkjet Papers, so click  
on that.
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Step Five:
Once you click that link, things get easier, 
because on the left side of the next page 
(under Helpful Info) is a clear, direct link 
right to their free downloadable color 
profiles (as seen here). Making profiles 
easy to find like this is extremely rare (it’s 
almost too easy—it must be a trap, right?). 
So, click on that Color Profiles link and it 
takes you right to the profiles for Epson 
printers, as seen in Step Six (how sweet 
is that?).

Step Six:
Under the section named Epson Wide 
Format, there’s a direct link to the Epson 
Pro 3880 (as shown here), but did you also 
notice that there are ICC Color profiles 
for the Canon printers, as well? See, the 
process is the same for other printers, but 
be aware: although HP and Canon both 
make pro-quality photo printers, Epson 
had the pro market to itself for quite a 
while, so while Epson profiles are created 
by most major paper manufacturers, you 
may not always find paper profiles for HP 
and Canon printers. As you can see at 
Red River, they widely support Epson, and 
many Canon profiles are there, too, but 
there are only a few for HP. That doesn’t 
mean this won’t change, but as of the 
writing of this book, that’s the reality. 
Speaking of change—the look and navi-
gation of websites change pretty regu-
larly, so if these sites look different when 
you visit them, don’t freak out. Okay, you 
can freak out, but just a little.
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Step Seven:
Although profiles from Epson’s website 
come with an installer, in Red River’s case 
(and in the case of many other paper man
ufacturers), you just get the profile (shown  
here) and instructions, so you install it  
yourself (don’t worry—it’s easy). On a PC, 
just Right-click on the profile and choose  
Install Profile. Easy enough. On a Mac, 
go to your hard disk, open your Library 
folder, and open your ColorSync folder, 
where you’ll see a Profiles folder. Just drag 
the file in there and you’re set (in Photo
shop CC, you don’t even have to restart 
Photoshop—it automatically updates).

Step Eight:
Now, you’ll access your profile by choos-
ing Print from Photoshop’s File menu. 
In the Print dialog, change the Color 
Handling pop-up menu to Photoshop 

Manages Color. Then, click on the Printer 
Profile pop-up menu, and your new color 
profile(s) will appear (as shown here). In 
our example, I’m printing to an Epson 
3880 using Red River’s Ultra Pro Satin 
paper, so that’s what I’m choosing here 
as my printer profile (it’s named RR UPSat 
Ep3880.icc). More on using these color 
profiles later in this chapter.

TIP: Creating Your Own Profiles
You can also pay an outside service to 
create a custom profile for your printer. 
You print a test sheet (which they pro-
vide), overnight it to them, and they’ll 
use an expensive colorimeter to mea-
sure your test print and create a custom 
profile. The catch: it’s only good for that 
printer, on that paper, with that ink. If any-
thing changes, your custom profile is just 
about worthless. Of course, you could 
do your own personal printer profiling 
(using something like one of X-Rite’s i1 
Solutions), so you can re-profile each time 
you change paper or inks. It’s really deter-
mined by your fussiness/time/money  
factor (if you know what I mean).
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Step One:
Go under Photoshop’s File menu and 
choose Print (as shown here) or just 
press Command-P (PC: Ctrl-P).

Step Two:
When the Photoshop Print Settings dia-
log appears, let’s choose your printer 
first. At the top right, choose the printer 
you want to print to from the Printer 
pop-up menu (here, I’m going to be 
printing to my Epson Stylus Pro 3880). 
You can choose your page orientation by 
clicking on the portrait and landscape 
Layout icons at the bottom of the Printer 
Setup section (as shown here). By the 
way, if you’ve used this dialog before in 
previous versions of Photoshop, you’ll be 
happy to know that now you can actually 
resize the dialog to any size you’d like by 
clicking on the bottom-right corner and 
dragging it out. Here I dragged it out 
to the right, so I could see my preview 
much larger, and it was at that moment 
that I realized I wasn’t seeing the full 
image (it’s not cropped that tight to the 
top of her head).

Making the Print 
(Finally, It All  

Comes Together)

Okay, so at this point, you’ve set Photoshop to the proper color space for the type  
of photo you’re going to be printing (RAW, JPEG, TIFF, etc., see page 3), you’ve 
hardware calibrated your monitor (see page 8), and you’ve even downloaded a 
printer profile for the exact printer model and style of paper you’re printing on.  
In short—you’re there. Luckily, you only have to do all that stuff once—now we can 
just sit back and print. Well, pretty much. Also, back in CS6, Adobe added some 
nice tweaks to the Photoshop Print Settings dialog, which we’ll cover here.
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Step Three:
If you want your image to fit fully on the 
page, scroll down to the Position and Size 
section and turn on the Scale to Fit Media 
checkbox (as shown here) and it scales the 
image down in size, so the entire image 
fits on the page without being cropped 
(now you can see the rest of her hat, and 
the image is much wider than what we 
saw back in Step Two). Just so you know:  
I have no problem turning this Scale to Fit 
Media checkbox on if my image is going 
to shrink in size to fit the paper, but if turn-
ing that on would wind up increasing the 
size, I’ll hit the Cancel button and go to 
the Image Size dialog (under the Image 
menu) and resize it there, so I have control 
over the upsizing process (see page 128 
in the book).

Step Four:
While we’re talking about size; there’s 
another Print feature added back in 
Photoshop CS6 called Print Selected 
Area, and it gives you the ability to just 
print part of your image (so, it’s kind of 
like cropping the print without actually 
cropping the image itself). You do this  
in the Position and Size section of the  
dialog by turning on the Print Selected 
Area checkbox. When you turn this on, 
you’ll see little arrows appear around  
the corners of your image. Just click-
and-drag these in toward your image, 
and as you do, it darkens the areas to  
be cropped away (as seen here, where 
I’ve dragged those arrows on the top 
left, top right, and lower left). Now, only 
the area that’s not darkened will actually 
wind up being printed on the page.
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Step Five:
Another resizing feature added back in 
Photoshop CS6 is the ability to just click-
and-drag on your photo to reposition and/
or resize it (I know what you’re thinking: 

“Couldn’t we always do that?” Believe it 
or not, no). To use this new feature, first 
make sure the Scale to Fit Media check-
box is turned off, and then click-and-drag 
the image around so you can reach a cor-
ner handle surrounding your image. Then, 
just click-and-drag a corner handle inward, 
and it resizes your image (kind of like Free  
Transform does, but you don’t have to 
hold the Shift key to keep the resizing 
proportional—it does that automatically). 
Here, I scaled the image down in size 
and positioned it where I wanted by just 
clicking-and-dragging it in the preview 
area. Now, before we go on to the next 
step, you’re probably wondering what 
that lined area around the outside edge 
of your paper is all about. That’s showing 
you where the margins are (the non-print-
able areas of your paper).

 

Step Six:
If you want to be able to print all the way 
to the border (and have those margin 
lines and non-printable areas go away), 
all you have to do is to set your margins 
to 0 inches. You do this by clicking on 
the Print Settings button in the top right 
of the dialog (it’s shown circled here in 
red) to bring up your OS Print (PC: Printer 
Properties) dialog (shown here at the bot-
tom). (Note: I use Epson printers, but if 
you have a Canon or HP, the dialog will 
have the same basic function, just in a dif-
ferent layout.) When you choose a paper 
size that is borderless (as shown here), you 
can now print to the edges of the paper 
(well, as long as your printer supports 
edge-to-edge printing, of course). Now, 
take a look at the preview—the margin 
area lines are gone.
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Step Seven:
Okay, now let’s turn on our Color Man
agement, so our prints will match what 
we see onscreen. In the Color Manage
ment section, you’ll see that, by default, 
the Color Handling is set up to have your 
printer manage colors (instead of Photo
shop). You really only want to choose 
this if you weren’t able to download any 
printer/paper profiles for your printer. 
Having your printer manage colors like 
this is your backup plan, not your first 
choice. But, today’s printers have gotten 
to the point that if you have to go with 
this, it still does a decent job (that wasn’t 
the case just a few years ago). Instead, I 
recommend that you choose Photoshop 

Manages Colors (as shown here). That 
way, it uses the color profile we down-
loaded earlier for our printer and paper 
combination, which will give us the best 
possible match.

Step Eight:
Next, you’ll need to choose that  
printer/paper profile you downloaded 
and installed earlier. So, from the Printer 
Profile pop-up menu, choose the printer/
paper profile that matches your printer 
and paper (here, I’ll choose the profile 
for Ultra Premium Photo Paper Luster). 
Now, Photoshop and the printer know 
exactly which paper I’ll be printing on, 
and it’s optimized to give us the best 
possible color print on that printer using 
that paper (this is very important, because 
this sends a whole series of instructions to 
the printer, including everything from the 
amount of ink it should lay down, to the 
drying time of the paper, to the proper 
platen gap for the printer, and so on).
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Step Nine:
Next, you’ll need to choose the Render
ing Intent. There are four choices here, 
but only two I recommend: either Relative 
Colorimetric (which is the default setting)  
or Perceptual. Here’s the thing: I’ve had 
printers where I got the best looking prints 
with my Rendering Intent set to Percep
tual, but currently, on my Epson Stylus  
Pro 3880, I get better results when it’s set 
to Relative Colorimetric. So, which one 
gives the best results for your printer?  
I recommend printing a photo once using 
Perceptual, then printing the same photo 
using Relative Colorimetric, and when you 
compare the two, you’ll know.

TIP: The Gamut Warning Isn’t for Us
The Gamut Warning checkbox (beneath 
the preview area) is not designed for use 
when printing to a color inkjet (like we are 
here) or any other RGB printer. It warns 
you if colors are outside the printable 
range for a CMYK printing press, so un-
less you are outputting to a printing 
press, you can leave this turned off.

Step 10:
Lastly, just make sure the Black Point 
Compensation checkbox is turned on (it 
should be by default) to help maintain 
more detail and color in the shadow areas. 
Now, click the Print Settings button in the 
top-right corner (we’re not quite done yet).

WARNING: If you’re printing to a color 
inkjet printer, don’t ever convert your 
photo to CMYK format (even though you 
may be tempted to because your printer 
uses cyan, magenta, yellow, and black 
inks). The conversion from RGB to CMYK 
inks happens within the printer itself, and 
if you do it first in Photoshop, your printer 
will attempt to convert it again in the 
printer, and your printed colors will be 
way off.
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Step 11:
In your OS Print (PC: Printer Properties) 
dialog (again, I use Epson printers, so your 
dialog may look different), your printer 
will already be chosen in the Printer pop-
up menu. On a PC, you’ll skip the Print 
dialog and just see your printer’s options. 
From the Layout pop-up menu, choose 
Print Settings (as shown here), so we can 
configure the printer to give us the best-
quality prints.

WARNING: From this point on, what 
appears in the Layout pop-up menu is 
contingent on your particular printer’s 
options. You may or may not be able to 
access these same settings, so you may 
need to view each option to find the set-
tings you need to adjust. If you’re using a 
Windows PC, you may have to click on the 
Advanced tab or an Advanced button to 
be able to choose from similar settings.

Step 12:
First, from the Media Type pop-up menu, 
choose your paper type. Then, choose 
your Output Resolution from that pop-up 
menu (on a PC, choose Quality Options 
from the Print Quality pop-up menu, then 
use the slider to set the quality level). I 
use SuperPhoto - 2880 dpi, because I 
want to get the highest possible quality 
(little known fact: at 2880 dpi, it doesn’t 
use more ink—it just takes longer). Next, 
choose Off (No Color Management) 
from the Color Mode pop-up menu (on 
a PC, click on the Custom radio button 
and choose Off [No Color Adjustment] 
from the Mode pop-up menu). You want 
no color adjustment from your printer—
you’re letting Photoshop manage your 
color instead. Now you’re ready to print, 
so click the Save (PC: OK) button to go 
back to Photoshop’s Print dialog, and hit 
the Print button to get prints that match 
your screen, as you’ve now color man-
aged your photo from beginning to end.
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Step One:
Start by downloading the free color  
profile from the company that makes 
the paper you’re going to be print
ing on (see page 11 for where to 
get these and how to install them). 
Open the image you want to soft 
proof, then under the View menu, 
under Proof Setup, choose Custom 
(as shown here).

Step Two:
When the Customize Proof Condition  
dialog appears, from the Device to Sim
ulate pop-up menu, choose the color 
profile for the printer/paper combo you’ll 
be using (here, I’ve chosen an Epson 
Stylus Pro 3880 printing to Velvet Fine 
Art Paper). Next, choose the Rendering 
Intent (see page 19 for more on this), 
and make sure you leave Black Point 
Compensation turned on. Down in the 
Display Options (On-Screen) section, 
leave Simulate Paper Color and Simulate 
Black Ink both turned off. You can toggle 
the Preview checkbox on/off to see a 
before/after of the simulation of what 
your print might look like with that profile 
on that paper (though, of course, it can’t 
simulate how your sharpening might look 
on different papers, just the color. Kinda). 
Give it a try and then compare it with  
a real test print, and you’ll be able to  
determine if soft proofing is for you.

This is only the second edition of this book to include how to do soft proofing,  
because I don’t use—or recommend—soft proofing myself, and I don’t want  
to include techniques I don’t really use. But, I have had so many people ask me  
about it, I felt I had to include it. Just know that my advice about this is simple:  
nothing beats a real proof. If you’re serious about making great prints, make a test 
print—soft proofing just gives you a hint of what it might look like. A test print  
is what it actually looks like. Okay, I’m off my soap box. Here’s how it’s done:

Soft Proofing  
in Photoshop
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Your Print Is Too Dark
This is one of the most common prob-
lems, and it’s mostly because today’s 
monitors are so much more incredibly 
brighter (either that, or you’re literally 
viewing your images in a room that’s too 
dark). Luckily, this is an easy fix and here’s 
what I do: Press Command-J (PC: Ctrl-J) 
to duplicate the Background layer, then 
at the top of the Layers panel, change  
the layer blend mode to Screen to make  
everything much brighter. Now, lower  
the Opacity of this layer to 25% and (this 
is key here) make a test print. Next, look 
at the print, and see if it’s a perfect match, 
or if it’s still too dark. If it’s still too dark, 
set the Opacity to 35% and make another 
test print. It’ll probably take a few test 
prints to nail it, but once you do, your  
problem is solved (by the way, this is a 
great thing to make into an action).

Your Print Is Too Light
This is less likely, but just as easy to fix. 
Duplicate the Background layer, then 
change the layer blend mode to Multiply 
to make everything darker. Now, lower 
the Opacity of this layer to 20% and make 
a test print. Again, you may have to make 
a few test prints to get the right amount, 
but once you’ve got it, you’ve got it. Now, 
make that into an action (name it some-
thing like “Prep for Print”) and any time 
you print, just run that action first.

Okay, what do you do if you followed all these steps—you’ve hardware calibrated 
your monitor, you’ve got the right paper profiles, and color profiles, and profiles  
of profiles, and so on, and you’ve carefully turned on every checkbox, chosen all 
the right color profiles, and you’ve done everything right—but the print still doesn’t 

match what you see onscreen? You know what we do? We fix it in Photoshop. 
That’s right—we make some simple tweaks that get the image looking right fast.

What to Do If the  
Print Still Doesn’t 
Match Your Screen
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Your Print Is Too Red (Blue, etc.)
This is one you might run into if your 
print has some sort of color cast. First, 
before you mess with the image, press 
the letter F on your keyboard to put 
a solid gray background behind your 
photo, and then just look to see if the 
image onscreen actually has too much 
red. If it does, then press Command-U 

(PC: Ctrl-U) to bring up Hue/Saturation. 
From the second pop-up menu, choose 
Reds, then lower the Saturation amount 
to –20%, and then (you knew this was 
coming, right?) make a test print. You’ll 
then know if 20% was too much, too 
little, or just right. Once you make a few 
test prints and nail it, save those steps 
as an action and run it before you print 
each time.

Your Print Has Visible Banding
The more you’ve tweaked an image, the 
more likely you’ll run into this (where the 
colors have visible bands, rather than just 
smoothly graduating from color to color. 
It’s most often seen in blue skies). There 
are two ways to deal with this: If you shot 
in RAW, make sure you keep the image 
in 16-bit mode (don’t have it down sam-
ple to 8-bit when it leaves Camera Raw). 
Click the Workflow Options link beneath 
the Preview area in Camera Raw, and 
choose 16 Bits/Channel from the Depth 
pop-up menu. Stay in 16-bit through the 
entire printing process. If your original 
was a JPEG, then there’s no going back 
to a 16-bit original (and just converting 
to 16-bit mode does nothing), so instead 
try this: Go under the Filter menu, under 
Noise, and choose Add Noise. In the  
dialog, set the Amount to 4%, click on  
the Gaussian radio button, and turn on 
the Monochromatic checkbox. You’ll 
see the noise onscreen, but it disap-
pears when you print the image (and 
usually, the banding disappears right 
along with it). 
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Step One:
To launch Contact Sheet II (the II part 
comes from the fact that this is the sec-
ond version of this automated script, a 
big improvement over the first one. But, 
honestly when I heard Adobe was bring-
ing this back, I was hoping for Contact 
Sheet III. Sigh), go under the File menu, 
under Automate, and choose Contact 

Sheet II (as shown here).

Step Two:
This brings up the Contact Sheet II  
dialog, where you get to choose how 
your contact sheet will look. You start  
at the top by clicking on the Choose 
button and selecting which folder of  
images you want to create a contact 
sheet of. In the next section down, Doc
ument, you get to choose the size and 
resolution of your contact sheet. In our  
example, we’re going to make a wide 
10x8" sheet at a resolution of 240 ppi  
(pretty standard resolution for a color 
inkjet printer). I always leave the Flatten 
All Layers checkbox turned on, so when 
it’s done I’m not looking in my Layers 
panel and seeing 36 different layers, 
and that’s pretty much what you’ll get  
if you choose not to flatten all layers.

For reasons known only to a secret society of Adobe engineers (who meet in  
underground catacombs buried deep below Adobe’s headquarters and lit solely  
by torches), they chose to remove the Contact Sheet feature from a previous  

version of Photoshop (CS5). I guess they assumed we’d use the PDF Contact Sheet  
in Bridge, which can only mean they never actually tried it themselves. Thankfully, 
after the public stormed Adobe’s headquarters with axes and pitchforks, they 

brought Contact Sheet II back in CS6, and the balance of power has been  
restored to the kingdom. Here’s how to unleash its wrath:

Making Contact Sheets 
(Yup, It’s Back!)
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Step Three:
The next section down, Thumbnails, is 
where you choose how many columns 
and rows you want. In our example, we’re 
going to do six across, with three rows 
deep. I generally leave the Use Auto-
Spacing checkbox turned on, because  
it has Photoshop do the math to figure  
out how to make the thumbnails in your 
contact sheet as large as possible. How
ever, if you turn that checkbox off, you 
can type in what you’d like for your verti-
cal and horizontal spacing (the only time 
I would do this is if I wanted more space 
along the top and sides. As you’ll see in 
the next step, this one has them spread 
out, so they’re really close to the side 
edges of the paper and pretty darn  
close to the top and bottom).

Step Four:
The last section, at the bottom of the 
dialog, is pretty important (even though 
I don’t have it turned on here), and that 
is the option for the filename of each 
photo to appear below the thumbnail.  
If you’re using this as a proof sheet for a 
client, that’s pretty important. My only 
recommendation for this would be to 
use a smaller font size than the default  
12-point, which always seems too large  
to me (especially if you have a long file
name). Try 9- or 10-point, and I also would 
try a sans serif font, like Myriad Pro (rather 
than the default Minion Pro), simply be-
cause it looks better. Now, click the OK 
button up top, and in about 20 or 30 sec-
onds, the contact sheet you see here  
appears. This particular one uses 18 
photos (6 columns by 3 rows), but if your 
folder contains more than 18 photos, it 
just keeps making more contact sheets 
until every photo is accounted for. S
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Photoshop Killer Tips
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Using CC on a MacBook Pro?
Then you’ve probably experienced a weird 
thing where all of a sudden your screen 
rotates, or your image suddenly zooms 
in (or out). It’s because the track pad on 
a MacBook Pro supports Gestures, which 
are great for most things, but tend to drive 
you insane when using Photoshop. You can 
turn off Gestures by pressing Command-K 

(PC: Ctrl-K) to bring up Photoshop’s Pref
erences, then click on Interface (in the list 
on the left) and, in the Options section, 
turn off the Enable Gestures checkbox.

Canceling an Adjustment Layer Edit
If you’re working with an adjustment layer, 
and you want to cancel your edit and re
turn to the adjustment defaults, click the  
curved arrow at the bottom of the Proper
ties panel. If you don’t want the adjustment 
layer at all, you can quickly delete it by 
clicking on the Trash icon, also at the 
bottom of the panel.

What’s That * Up in Your 
Document’s Title Bar Mean?
That’s just letting you know that the image 
you’re working on has an embedded color 
profile that’s different from the one you 
chose in Photoshop (for example, you’d 
see this if you brought an image over from 
Lightroom, whose default color space is 

ProPhoto RGB, but Photoshop’s default 
color space is sRGB, so since the two don’t 
match, it just puts that asterisk up top in 
case you care).

Tip for Finding Out Which Fonts 
Look Best with Your Layout
This is a handy tip, especially if you’re do
ing poster layouts, and you want to find 
just the right font to complement your 
photo. Go ahead and create some type, 
then double-click on the Type layer’s 
thumbnail in the Layers panel to select 

all your type. Now, click your cursor once 
in the Font field up in the Options Bar, 
and you can use the Up/Down Arrow 

keys on your keyboard to scroll through 
all the installed fonts on your system, 
and your highlighted type changes live 
onscreen as you do.

Refining Your Masks  
Using Color Range
If you’ve created a layer mask, and want to 
tweak it a bit, you can add the Color Range 
feature as part of your tweaking arsenal.  
I use this to quickly select images that are 
on a white background. Try this: Click on 
the Add Layer Mask icon at the bottom 
of the Layers panel (you’ll have to be on  

a duplicate or unlocked layer), then go 
under the Select menu, and choose Color 

Range. With the first Eyedropper tool on 
the left (below the Save button), click on 
the background once (not in the image 
itself, in the mask preview right there in 
the Color Range dialog), and then raise 
the Fuzziness amount until it selects the 
background. That usually does most of the 
masking for me. Click OK, and now you can 
quickly paint in any missing parts using the 
Brush tool set to paint in black. This gives 
you a mask of the background selection. 
To make your mask a selection of your sub-
ject, make sure the mask is selected, and 
press Command-I (PC: Ctrl-I) to Invert it.

Change Your Background  
Canvas Color
By default, the area around your docu
ment is a dark gray color, but you can 
choose any color you’d like by just Right-
clicking anywhere on that gray canvas 
area and choosing Select Custom Color 

from the pop-up menu.


